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Functions & Formulas Fundamentals

The following definitions are necessary to understand the basics of creating Excel
formulas and functions.

Formula Definition

A formula allows you to calculate and analyze data in your worksheet. Formulas perform
calculations such as addition or multiplication; formulas can also combine values.

Formula Syntax

Formula syntax is the structure or order of the formula elements. All formulas begin with
an equal sign (=) in Excel followed by operands (the data to be calculated) and the
operators. Operands can be values that don’t change (constants), a range reference, a
label, a name, or a worksheet function.

Formula Bar

The Formula bar is an area located at the top of the worksheet window that is used to
enter or edit values or formulas in cells or charts. The Formula bar displays the constant
value or formula in the active cell. To display or hide the Formula bar; select from the
Menu bar, View > Formula.
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Function Definition

A function in Excel is a built-in formula that performs a mathematical operation or
returns information specified by the formula. As with every formula created in Excel,
each function starts with an equal (=) sign.

Function Syntax
The syntax of a function begins with the function name, followed by an opening
parenthesis, the arguments for the function separated by commas, and a closing

parenthesis. If the function starts a formula, an equal sign (=) displays before the function
name. Example: =SUM (D2:F8)

Last Updated: October 26, 2005 20f9



Academic Computing Center - AUB Excel 2003 - Tutorial 111

http://staff.aub.edu.lb/~acc/

In the above example, the function name is Sum and the argument for the function is the
range “D2:F8”.

Arguments

An argument is the reference behind the function. The reference can be any of the
following type:

Argument Types
Argument Example
Numbers 12,3
Text "January"
Logical Values (True or False)
Cell References / Range B7 or B7:B20

Operators

Operators are mathematical symbols that are broken into four categories

Keystroke Operators
Arithmetic Explanation Example
+ Addition 2+3
- Subtraction 5-1
* Multiplication 7*3
/ Division 712
% Percent 90%
N Exponentiation 712
Comparison Explanation Example
= Equal to B1=D1
> Greater than B1>D1
< Less than B1<D1
>= Greater than or equal to B1>=D1
<= Less than or equal to B1l<=D1
<> Not equal to B1l<>D1
Text Explanation Example
& Adjoins text or cell references Scott & Hi p.ruoduces
Scott Hi
Reference Explanation Example
Includes cells of a column or row .
between the designated limits B3 :B20
, Separates arguments in a function (B3, B20)
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Operator Order

Formulas are calculated left to right, using order of precedence, the parentheses have high
order of precedence, i.e.: every thing inside them is evaluated first.
Excel performs operations in the order shown in the following table.

Excel's Operator Order
Arithmetic Operator Precedence Example
1 % Percent
2 A Exponentiation
3 * Multiplication, Division
4 +, - Addition, Subtraction
5 & Ampersand
6 > >= < <= = <> Comparisons

Notice that percent has the highest precedence, multiplication and division have same
order of precedence, also addition and subtraction have same order of precedence.

Excel performs all operations within sets of parentheses first, and you can use this to get
exactly the order of operations you want. If multiple operations are encased in multiple
sets of parentheses, the operations are performed from inside to outside, then follow the
order of operations, and then left to right.

Function Wizard

The function wizard is designed to help provide the necessary arguments and descriptions
for the various Excel functions.
1. Select the cell in which you

want the results of the

funCtion to dISplay Search for a Function:
2. CIICk the Insert Function Type a brief description of what wou want to do and then '
button . ¥ on the Formula =
. Or select & category: | Mosk Recently Used A
toolbar or select Function
Select a Function:
from the Insert menu.
i UM ]
3. From the Insert Function EoD 2
dialog box, browse through FERAGE
the functions by selecting a COUNTIF
. AVEDEY
Function category from the | STDEY v
drop-down menu, and select SUM(number1,number2,...
the funCtion from the ||St Adds all the numbers in a range of cells,
below. As each function
name is hlgh“ghted a Help on this Funckion ok l [ Cancel
description and example is

provided below the two
boxes.
4. Click OK to select a function
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5. The next window allows you [ x||
to choose the cells that | o
contain the arguments of the Number1 | B2:C2 (el = 23
function. In this example, cell Humber2 (ul=
B2 and C2 are selected to =s

Adds all the numbers in a range of cells.

compute their sum. The
values of the cells B2, and C2

Mumber1: number1,numberz, ... are 1 to 30 numbers to sum. Logical values and text

are reSpeCtiver 2’ and 3 are ignored in cells, included if typed as arguments,
Excel identifies the range of | romsresut= 5
the Ce”s n the funCtlon to Help on this function (s ][ Cancel

(B2:C2). In the lower part of
the Function Argument
dialogue box you can see the
Formula result.

6. Click the OK button.

Entering Multiple Formulas All At Once

To enter the same formula in several cells at once, follow these steps:

1. Select all the cells you want to enter the formula in.

2. Create your formula, but don’t press ENTER when finished.

3. When the formula is complete, press CTRL + ENTER. The formula is entered in all
the selected cells simultaneously.

Editing & Deleting Formulas

You can also edit or delete any formula. To delete a formula, click on the cell that
contains the formula, and press the DELETE key on your keyboard. If you need to alter
the formula, follow these steps:

1) Click on the cell that contains the formula.
2) Click on the Formula Bar and make changes to your function.
If the formula uses a built-in Excel function:
1) Click on the cell that contains the function to select it

2) Click on the Insert Function 2 button on the formula bar to edit the
function arguments. Change the appropriate argument(s) and click OK.

Errors in Formulas
When a formula is prevented to run normally, Excel will notify you with an error

message. Each error message helps users identify the problem they are facing. The
following table lists common Excel errors that you might face.
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Error Meaning How to Fix
sttt The column is too narrow to display the | Widen the column
result of calculation
Wron e of argument or reference Check operands and arguments
#VALUE gtyp g p g
Data is attempting to divide by zero Change the value or the cell reference
#DIV/0! so that the formula doesn't divide by
zero
Formula is referencing an invalid name | Be sure the name still exists or correct
#NAME? the misspelling
Excel can't locate the referenced Click Undo to restore references and
#REF! cells(for example, the cells were then change formula references
deleted)
Reference to intersection of two areas Check for typing and reference errors
#NULL that do not intersect

Excel Functions Overview

Statistical Functions Overview

Statistical functions are among the most widely used functions in Excel.

AVERAGE(range)

Calculates the mean (arithmetic average) of a range of cells

COUNT((range) Counts the number of values (cells containing numbers in a range)

COUNTIF(range, value) | Counts the number of cells that are the same as a specified value.

MAX(range) Returns the maximum value of a data set.

MIN(range) Returns the minimum value of a data set.

MODE(range) Returns the most frequently occurring, or repetitive, value in a
range of data.

STDEV(range) Calculates the standard deviation of a sample.

Given that:

e Range: Represents the set of values (numberl, number2...)
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e Value: The criteria upon which you want to evaluate; it can be a number (14), a
cell reference (G5), an expression (E5>7), or text (“Victor”).

Math Functions Overview

Math functions in Excel can be used to perform calculations as stand-alone functions or
combined to create complex formulas. Excel has a great number of Math functions but
the most commonly used ones are:

PwnE

Sum

Round
Ceiling
Floor

You can use the Round (), Ceiling (), or Floor () function to round a number to any
number of digits you want.

1.

Sum Function

= Adds the numbers in a range or multiple ranges of cells.

= Written as: Sum (numberl, number2...)

= Numberl, Number2..: are written as a number, a reference to a cell, or to
a range of cells for which you want the total value or sum.

Round Function

Rounds a number to a specified number of digits.

Written as: Round (number, num_digits)

= Number: The value you want to round.

Num_digits: The number of decimal places you want to round.

Ceiling Function

= Returns number rounded up, away from zero, to the nearest multiple you
specify.

= Written as: Ceiling (number, significance)

= Number: The value you want to round

= Significance: The multiple you want to round to

Floor Function

Rounds number down, toward zero, to the nearest multiple you specify.
Written as: Floor (number, significance)

Number: The value you want to round.

Significance: The multiple you want to round to

Information Functions Overview
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Information functions are generally made up of logical results and can be used in many
business situations. Combined with other functions, the information functions can
manage lists of data and provide feedback based on a logical result. The most usefull
function is:

IsNumber Function

= Returns true if the value is a number.
= Written as: ISNUMBER (value)
= Value: this is the cell or range you want tested.

Overview of Logical Functions

Logical functions test cells & ranges and can return only: True or False. Commonly used
logical functions are:

AND
OR
NOT
IF

MPwnh e

1. AND Function

= Returns True if all the logical arguments are true.

= Returns False if one or more arguments is false.

= Written as: AND (logicall, logical?2 ...)

= Logical Value 1, 2 ... : The test results in a logical TRUE or FALSE
return. Up to 30 conditions can be tested together.

2. OR Function

= Returns False if all the logical arguments are false

= Returns True if one or more arguments is true

=  Written as: OR (logicall, logical2...)

= Logical Value 1, 2 ...: These are the conditions to be met to test a
logical true or false result. You can use up to 30 conditions within the
formula.

3. NOT Function
= Returns the opposite of the logical value
=  Written as: NOT (logical)

Logical : This is the value that can be evaluated with a True or False
Condition. If True, NOT returns False, if False, NOT returns True.
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4. |IF Function

= The IF () function decides the contents of a cell on a spreadsheet based
on whether a test condition is true or false.
= It returns a value if one condition is True, and returns another value or
result if the condition is False.
= Written as: IF (logical_test, value_if: true, value_if false)
Logical_test : Is any value or expression that can be evaluated to True
or False.
VALUE IF TRUE : Is the value returned if the logical_test is True.
VALUE IF FALSE : Is the value returned if the logical_test is False

The operators in the logical_test of the IF function may be:

= | Equal to

<> | Not equal to
> | Greater than

> = | Greater than or equal to
< | Less than

<= | Less than or equal to

Note: Nested IF () Function
If you wish to test more than one condition, you can nest an if () function within another

=if (logical_test, result_if _true, if (logical_test, result_if _true, if (logical_test,
result_if _true, result if false))

Example: If (I am married, If (I get a child, I will send him/her to AUB))

Additional Readings
Text to Speech
To hear the text in your worksheet:
1. Show the Text to Speech toolbar by selecting from the Menu bar, View >
Toolbars > Text to Speech
2. Highlight the cells you want to convert to speech

b
3. Press on speak cells button . found on the Text to Speech toolbar
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